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Loading the Scanner

SCANTRON. _

1. Depress and hold the button labeled Press to Load
2. Inthe right tray, place forms face up with the black marks on the left and bottom
a. Answer key(s) should be on top
b. Do not fill above the Maximum Sheet Level line. You will have the
opportunity to add more forms later.
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I have read and agroe to the ESF Academic Integrity Code.
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3. Release Press to Load Button
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Opening Software and Scanning Completed Forms

1. Login to the computer using your ESF credentials
2. Open Remark Classic OMR Software
3. Click Open Other Templates

Rernark Classic OMR Data Center
FILE EDIT VIEW TOOLS HELP

x| B4 &
TEMPLATES

Recent

& Open Other Templates

'8 Batch Creator

4 Import Scantron Score Data

4. Navigate to the OMR-Image folder
a. ... \Remark Classic OMR\Templates\Scantron\OMR-Image
5. Select the form number that matches the number on your sheets
a. The ESF form is 298758-1
6. Click Read

f—
Remark Classic OMR Data Center - Form 88483 rst [Untitled (1)]
FILE EDIT WVIEW TOOLS HELP

=] 4 o x v

TEMPLATES DATA ANALYSIS

Student Man Sex Grade Level Maonth

Data Optiors 2
m Read.. 3

& Open Data

.:', = = Open Data )g @ x % [ Read... :,:_i}"Quicl_c Scan

Day
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7. Choose your Printing Options
a. Check Enable Imaging
i. What this does: saves an image of the scanned form and helps
when reviewing documents
b. Optional: to print directly on the bottom right of the form,
I. Check Print on forms at position (mm) and choose a number
larger than 5
ii. Under Print Options, select the options you want printed
1. Example: record number, text, or percent total score (only if
you have one test version and the key is the first form you
scan)
2. Click Insert

Claszic Read

Which scanner would you like to use to collect your data?

Scanner Source

The scanner to use to process your forms,

. Print Options
iMNSIGHT 4 Tmage]
Choose an item [or items) to print and/or add your
ﬂ- Scanner Properties... own custom text.

iINSIGHT 4 (Image) Optio

The status of the scanner's ha

mponents.

0 _ P Select Printing Options
Print on forms at position [mm): I = .
— l:n] from this dropdown
Enable imaging 1.
a.
Cancel MNext == Read -
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8. Click Next
a. Optional: If you would like to save each scanned form with a unique file

name such as Form Number and Name, use the Name Builder

Classic Read
How would you like us to handle your image archiving?
Begin image names with: |[Template Name] -
Destination folder: ChUsers\Scantron\DocumentstRemark Classic OMR\Images
Mame Builder...
;aveimages in a subf n the form template's name
Saved image as: TIF hd
Compression level: Lw v
Save multi-page form templates as multi-page image files
F‘D Please note that image names will also contain the date and time of when they were processed as well as the
@ corresponding form template page if applicable,
i.e, C\Users\Scantron\Documents\Remark Classic OMR\mages\Form 221666 (L-5)\[Template Mame]
2016-02-29_15-31-51-27 tif
Cancel << Back Hext == Read -

9. Click Next
a. Recommendation: Ensure Disable Review Exceptions is selected in blue

or uncheck all the options so that all scanning happens all at once. You
will have the ability to review all this same data once the forms are

scanned.

Classic Read
Would you like to perform on-the-fly reviewing of your data?

Clean Your Data
Qf Review any data exceptions encountered during the read process.
Disable Raview Customized exception searches

Exceptions On-the-fly data review (suspends processing)

[ Multiple responses

[ Blank responses

[ Input regions

D Database lookup regions

[ Reguired items

Lancel << Back Read -

10.Click Read
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11.Forms will scan and, if there are errors, a notification will pop up. Follow
directions under Recovery Recommendation.
a. The following notification appears when the input tray is empty.
I. To keep scanning, add more sheets and click Resume Scan.
ii. If there are no more sheets, click End Scan.

Scanner Status

Scanner Status b ) |

Returns the current scanner and session status and provides recovery recommendations. \*

e
ﬂ‘" Status Messages
> Input hopper empty.

= Scanner not ready.
> Expected sheet: Start of document (1)

Recovery Recommendation
Add sheets to the input hopper.

KINDKIEND

Resume Scan End Scan
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Example Output under Data Tab

[@] Remark Classic OMR Data Center - Form 221666 (1-5).rst [Untitled (1]]
FLE EDIT VIEW TOOLS HELP

E & i openData B} B _ i€ B [ X Q i MIResd.. #{QuickSen & B QickOrede [ Advanced Grade ~ Quick Survey
N
E | "j ."f REVIEW X o | HALF RIGHT “
TEMPLATES DATA ANALYSIS
Name Gender  Gradelevel Month  Day Year D Special Codi Questionl Question2 Question3 Questiond Questions Questio_{
1 ALLRIGHT 10 Mar pil 1947 0123456789 987654 1 2 3 4 5 1 M
Data OPtIO S 16 Dec 1 1976 9999999999 666656 1 2 3 4 5 1
[0 Read.. 3 ALLRIGHT 10 Mar it 1947 0123456789 987654 1 2 3 4 5 1
& Open Data 4 HALF RIGHT 16 Dec 1 2 3 4 5 1
5 QUARTERRI 0 Feb i 2 3 4 5 1
. ) 6 ALLRIGHT 10 War 2 D O 2 3 4 5 1
Review Exceptions ata UtpUt
7 ALLRIGHT 10 Mar il 2 3 4 5 1
Review Duplicate Records
3  QUARTERRI 0 Feb E 2 3 4 5 1
9 HALF RIGHT 16 Dec 1 1976 9999999939 666666 1 2 3 4 5 1
Save Data 10 ALL RIGHT 10 WMar 2 1947 0123456789 987654 1 2 3 4 5 1
[E Save Data As 11 HALF RIGHT 16 Dec 1 1976 9999999939 666666 1 2 3 4 5 1
12 ALL RIGHT 10 WMar 2 1947 0123456789 987654 1 2 3 4 5 1
Advanced
13 ALLWRONG BLANK  BLANK 0 o BLANK  BLANK  BLANK  BLANK  BLANK  BLANK
14 ALLWRONG BLANK  BLANK 0 0 BLANK  BLANK  BLANK  BLANK  BLANK  BLANK
15
16
k 17
B Multiple Response:
18
M Blank Responses
. b 3
M Input Regions 2 f< | v | w| Form 221686 [1-5).rst [Unti... [« L4
p Regions Image Viewer - Form 221666 [1-5) 2016-02-29_15-29-33-12.tif [page 1] o0 O @ X carF Bt @b X
rcode Regions - &

Itiple Exceptions

EEE @ Name
v LIt
7

L, 20583 Image Of

Explaining
Colors

e Exam/Quiz

5 W
£ % E ¥ g & % R
GrEr @ D208 | Gr5r D> 00 8rOrErIoEr e [ ]

Graph of responses of
highlighted column
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Reviewing Responses (Optional)

Also known as Reviewing Exceptions, this step allows you to review the raw data for
entries that might be of interest such as multiple responses and blank responses.

1. Under Data Tab, Click Review Exceptions

Remark Classic OMR Data Center - Form 221666 (1-5).rst [1
FILE EDIT MEW TOOLS HELP

%E;--' =GpenData%ﬁ'§}g®

E 1 G

TEMPLATES DATA AMALYSIS

Data Options

M Read..

& Open Data

& Review Exceptions

[} Review Duplicate Records
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2. Select the options you would like to review

3. Click Next

Remark Classic OMR Data Center - Form 221666 (1-5).rst [Untitled (1)] (Review Exceptions Is Running)

Review Exceptions
Options

Choose one or more of the
options below to dynamically
way we search your data for e

|Search By Rows iv

Multiple Responses

M Blank Responses

Input Regions

M Database Lookup Regions
M Barcode Regions

B Required ltems

Review Tip! You can optionally click &
drag an area of the grid in which to
search before starting the review

Updated January 2017

END REVIEW | &

Name

|ALL RIGHT

HALF RIGHT

Image Viewer - radFCA26.tif [page 1]

ALL RIGHT
HALF RIGHT

QUARTER RI a
M|« ¥ M| Form 221666 (1-5).rst [Unti...

Review Exceptions Running (Speech Off)
5]
7 & || ALLRIGHT

PREVIOUS |~ NeT |-

Gender Grade Level Month Year D
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10

12.Review and, if desired, make changes
a. The example below shows a response that processed as blank. The
associated image is from that person’s form and question number.
b. This feature is also useful if you'd like to review where multiple responses
were recorded.

|©] Remark Classic OMR Data Center - Form 221666 (1-5).rst [Untitled (1)] (Review Exceptions Is Running) =h B T

Review Exceptions Running (Speech Off)
u]

enDReview | & || previous |~ NEXT || x || -

ReVIeW Exceptlons Question14 Questionl5 Questionlé Questionl7 Questionl8 Questionl9 Question20 Question2l Question22 Question23 Question24 Question25 Question26 Questio_*|

OptiOﬂS 14 5 1 2 3 4 5 1 2 3 4 5 1

2
- . 3 .
Choose one or more of the review |" s : 2 3 4 5 b 2 3 4 5 BLANK

options below to dynamically change the 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2
way we search your data for exceptions. 1 5 1 2 3 3 5 1 2 R 4 5 BLANK BLANK

Search By Rows - 5 BLANK BLANK  BLANK BLANK  BLANK BLANK BLANK  BLANK BLANK  BLANK BLANK  BLANK BLANK BLANK -

Multiple Responses /4| » ¥ Form 221686 (1-5.rst [Unti.. |4 3
Image Viewer - Form 221666 (1-5] 2016-02-29_15-29-38-12.tif [page 1] = o0 0 @ X Gapr [CREC AN CRAN RS 4

Blank Responses

Input Regions 4 m m - .
M Database Lookup Regions Question26

B Barcode Regions 8
B Required Items h @ b @ b @ b
I
Review Tip! You can optionally click &
drag an area of the grid in which to
search before starting the review E
process. |
:’®” @“ @” A
: @ : @ : @ m ’

M@eam@m@m .

1 3 5
2 4 Missing

-

13.When done, click End Review
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11

Analyzing and Grading

Do you want Quick Grade or Advanced Grade?
e Choose Quick Grade if you only have one test version and it was the first form
scanned.
e Choose Advanced Grade if you have more than one test version and answer
key and you want the grade analysis to combine all the versions into one report.

Quick Grade

Click Quick Grade on the right side of the top ribbon.

Remark Classic OMR Data Center - Form 298758-1.rst [Untitled (1)]
FILE EDIT VIEW TOOLS HELP

% k = '-"lOpen Data % ﬂ . % )ﬁ @ x Q . % mﬁead... ;}i}'Quick Scan Q % EQuicerade I Advanced Grade -

LY
E I *’| ./'.1 REVIEW X« || BLANK
TEMPLATES DATA ANALYSIS

MAME LISER MAME Version Questionl Question2 Question3 Questiond Questions Questiond

Move on to the Grade Reporting Section

Advanced Grade

1. Click the Analysis tab

2. Click Advanced Grade
Remark Classic OMR Data Center - Form 221666 (1-5).rst [U
FILE EDIT VIEW TOOLS HELP

%I},= =OpenData%ﬁv§ﬁ®

=] [ 4

TEMPLATES DATA AMALYSIS

Analysis Options

B Quick Grade
A Advanced Grade
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12

3. Define grading parameters by using the 5 tabs on the left
a. Test Options
i. Edit Grade Scale - you can define percentages and letter grades
ii. Use atest benchmark - this will show up on the final reports
lii. Use custom report headers - these will show up on every report
you view/save/export

Advanced Grade

Test Options Basic Test Options
Answer key file:
Answer Key

Question Proper‘ties Open an existing answer key file if you would like to preload the advanced grade settings based on a previously saved configuration,

Learning Objectives Overall test grade scale: Edit Grade Scale... $ Overall test scaled score: | Edit Scaled Score..,
Test Versions Use a test benchmark: Class Average -

Use custom report headers

Top-Left report header: Date hd
Top-Center report header: |Exam 1 hd
Top-Right report header - MoreOptlons

Custom Report Header Preview

2202018 Exam 1

E Save.. hd Grade Cancel
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b. Answer Key

13

i. If you have one answer key, select that here and click Import

Key...

ii. Multiple test versions? Move on to Test Versions

Advanced Grade
Test Options Define/Import Test Answer Key
Answer Key

Question Properties

Import answer key from: |Data Set (Grid) Row

? Correct Answer

Mame |
Learning Objectives

Gender
Test Versions Grade Level

Maonth

Day

Year

D

Special Codes
Questionl
Question2
Question3
Questiond

Questions

Grade All Grade Mone

-
b 14 Import Key...
Grade As Objective Grade As Subjective i‘
Ed
Ed
Ed|
Ed
Ed

Grade Cancel

c. Test Versions

i. Check Define multiple test versions if you have multiple answer

keys

Advanced Grade
Test Options

Answer Key

Question Prg CH %
Learning Objectives E

Test Versions

Define Multiple Test Versions

D Define multiple test versions

hultiple Test Versions

Allows you to create multiple versions of a single test.

Help prevent cheating
Driversify test distribution
Simplify test generation process

Save time and effort
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ii. Click Standard (Multiple Keys)

iii. Select which field identifies the test version

14

Advanced Grade
Test Options
Answer Key
Question Properties
Learning Objectives

Test Versions

Define Multiple Test Versions
Define multiple test versions

Ix >

Standard Advanced
[Multiple Keys) [Question Order)

Standard Test Versions

Multiple answer keys

Cuestion order maintained

Define a different answer key for each version of the the test.

Which guestion’s answer identifies the test versions: §5pecial Codes

i Create Version

iv. For each version:

a. Click Create Version

b. Select where the answer key comes from

c. Click Import Key

Advanced Grade
Test Options
Answer Key
Question Properties
Learning Objectives

Test Versions

Define Multiple Test Versions
Define multiple test versions

[ 3

Standard Advanced
[Multiple Keys) [Question Order)

Standard Test Versions

Multiple answer keys

Cuestion order maintained

Which guestion's answer identifies the test versions: |Special Codes
Answer Keys (2]

Import answer key from: |Data Set (Grid) Row

Define a different answer key for each version of the the test,

.

T K

987654 G666
Questionl 1 1
Cuestion2 2
Cuestions 3 3
Questiond 4 4
Question5 5 5
A

Delete Key 2
E Save.. -

Grade Cancel

d. Click Grade

Updated January 2017
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Grade Reports

15

1. After Quick Grade or Advanced Grade finish, Remark Quick Stats opens
a. Here you can review the different reports. Make notes of which ones you
find interesting because you can use Report Batches to export and save

all the reports of your choice to a pdf or other format.
b. Report suggestions:

i. Class and Student Reports
1. 101
2. 105
3. 150

ii. Item Analysis Reports
1. 206

Downloading Reports - Report Batches

1. Click Report Batches

EﬂRemark Quick Stats - Advanced Grade = 3
FLE EDIT VIF o /
Export Report mﬁmail Report L‘ﬁ E IE Ez' . ==- -j- -©] ° Page Width - o 1/1 -
j Report Style - Data x
Sort B
) ) e et Sort Students Unsarted ;'
I Favorites (0) )
) Sort Order Ascending -
Overall Cam Avsnge §EF . o
& Class And Student Reports (9) == = = — Data to Display on Report 2
. foeiile=a ] L B wooo Grade Yes =
. 100 - Test Analysis e e : i o —— 3
] . 20+ 0 e Scaled Score Yes g
4 101 - Student Statistics ST T ez : s e EmT— Total Score Yes
i F w0 D0 0 FRARR] T
_ . _ A Lo otzsaseTee A ERE] ool .
. 102 - Comparative Grade e e E e B = Extra Credit es g
| b E i = Percent Score Yes m
4. 103 - Class Frequenc Fe = B E— . o
ah. é) .b_ a.qq Frequency = Tz = Achievement Gap Mo <
Istribution
¢ Z Scare No 8
o 5
. 105 - Student Response T Score No o
& 107 - Demographic Grade ETS Score No o
Deviation IQ Mo =
i 112 - Student Achieveme _
. 112 - Student Achievement Percentile No [
. 150 - Student Grade Objective Perce.. No
_ _ ol Suden: StESTS Repor Page 1 Corred Nﬂ
. 160 - Student Response
Similarities Incorrect No
Missing Mo

Updated January 2017




2. Click Next

Report Batches

Report batch file:

Cpen an existing report batch file if you would like to preload settings based on a previously saved configuration.
Optionally choose fields below on which to filter your data, generating a new report for each
value.

[ Filter reports by {Lst): A4

D -

D -
Cancel MNext )

3. Select reports and use the arrows to select or deselect reports

Report Batches
Filter: Selected reports:
Primary - Selected Reports Filter
: 101 - Student Statistics Primary
Ayailable reports: 105 - Student Response Primary
100 - Test Analysis B 150 - Student Grade Primary
101 - Student Statistics 206 - Condensed Test Primary

® 102 - Comparative Grade
103 - Class Frequency Distribution
105 - Student Response
® 107 - Demographic Grade
112 - Student Achievement
150 - Student Grade
180 - Student Response Similarities
201 - Detailed Item Analysis
203 - tem Analysis Graph

204 - Condensed Item Analysis (
206 - Condensed Test
® 220 - Integrated Item Analysis E «

Reports with a red bullet may require user input before they can be generated.
Choose the appropriate selections when prompted.

Cancel £ Back Mext » Finish

4. Click Next

Updated January 2017
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5. Click Next

Report Batches
D Print Reports: Send To OneMote 2010
Mumber of copies 1 :
Twao-sided printing: [Mone -
O
Cancel ( Back

Einish

-

6. Select Export reports as:

Report Batches

Display the reports upon completion
+ |Portable Document Format [PDF)

7. Click the 3 dots to pick a file location and name for the output

Report Batches

Display the reports upon completion
Export reports as: | Portable Document Format (PDF)

Merge all selected reports into a single file

O

Base file name:

Image guality: | High -

Cancel £ Back

Finish

-

8. Click Finish
9. Click ok

Updated January 2017
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Save an Excel File with Grades

1. Click the Data tab
2. Click Export Numeric Data & Grade Results
3. Follow the prompts to save your file as a comma separated file (.csv)

:ﬂ Remark Quick Stats - Quick Grade
FLE EDIT VEW TOOLS HELP

%AdgancedGrade = % I-_‘A E @
i

n
REPORTS

Export Options

=+ Export Textual Data
Export Numeric Data
Export Textual Data And Grade
Results
Export Numeric Data & Grade
Results

Y e I I N

P — FRTRLT

Row-based Learning Objectives

Export Numeric Data And
Row-based Learning Objectives

Export Gradebook
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Saving Files to use again in Remark software

To save the raw data:
e Go to the Data tab
e Click Save Data As
o Select .rmx to open in remark later

o Select .csv to open in other programs
Remark Classic OMR Data Center - Form 221666 (1-5).rst [U
FLE EDIT VMEW TOOLS HELP

':"= =0penData%m'§}€®

a
AMNALYSIS

=]

TEMPLATES

Data Options
0 Read..

= Open Data

& Review Exceptions

7y Review Duplicate Records

B Save Data

[E Save Data As

To reopen the original data:

19

e you must pick a template in the Templates tab, then you can “open Data” under

the Data tab

Remark Classic OMR Data Center - Forrm 221666 (1-5).rst |
FILE EDIT WEW TOOLS HELP

Y ¢ §
- r A
= 4 ]
TERPLATES DATA AMALYSIS

Data Options

m Read..

& Open Data
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To save graded reports in Remark Quick Stats (to open in Remark at a later date):
e Click File > Save
e Choose .rgs file extension

Eﬂ Remark Quick 5tats - Advanced Grade
HLE EDIT MEW TOOLS HELP

% Adganced Grade m Report Batches L‘AEzportReport mgmailReport L‘ﬁ E IE E= ==v -é- - @] Q Fage Width - o

& Eﬂ Save Report Data... @
REH F‘D | . v Scantron Admin » My Decuments » Rernark Classic OMR » - |¢f | | Search Remark Classic OMR 2 |
Organize « Mew folder ZE=l .@.
Jr Favorites Name . Date modified Type Size
B Desktop . Analysis Definitions 1/26/2016 9:28 AM  File folder
4. Downloads . Data 1/26/2016 9:28 AM  File folder
15| Recent Places . Images 2/29/2016 5:17 PM File folder
- . Templates 1/26,/2016 3:28 AM File folder
4 Libraries 1
3 Documents
J‘- Music
le=| Pictures
B Videos -

'8 Computer
&, Local Disk (C:)

AR TR L P

File name: | -
Save as type: ’Report Data Files (*.rgs] v]
“ Hide Folders Save l [ Cancel ]

More Help

User Manual is located Program Files > Remark Classic OMR - Documentation

Contact Heidi Webb (Moon 9D) and/or Ellen Edgerton (Moon 101)
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